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Chapter 1: Introduction 

What is Metrix? 
Welcome to Metrix Utility Accounting System, the ultimate utility accounting software package! 
Metrix offers easy importing of bill data, rigorous cost avoidance methodology, and ExcelÊ-based 
reporting. This power-packed version of Metrix combines exciting new features with the 
established functionality that energy engineers and energy managers have come to rely on. 

With Metrix, you can:  

¶ Identify problem areas or equipment failures in order to reduce operating cost overruns. 

¶ Determine whether you are meeting your utility performance targets. 

¶ Compare the operating costs of different facilities. 

¶ Compare the cost-effectiveness of available utility tariffs for your usage profile. 

¶ Track utilities for any type of facilityðcommercial, industrial, institutional, residential, etc. 

¶ Track almost any type of utility, including electricity, natural gas, water, heating oil, 
propane, LP gas, solid waste, sewage, and so on. 

¶ Track one meter or hundreds, one building or many sites. 

Who Uses Metrix? 

Metrix is for anyone who tracks, budgets, and verifies utility operating costs and savings. Metrix 
provides real answers for tough questions:  

¶ ñIs our energy management program saving as much as we expected?ò  

¶ ñWhere is my best opportunity for reducing operating costs?ò  

¶ ñAre we achieving our performance goals?ò  

¶ ñWould I be better off with a different rate tariff?ò 

Metrix is used by facility managers, energy managers, property managers, energy analysts and 
energy consultants who want to track utility usage and determine cost avoidance. Some of our 
customers who have found the greatest benefit include: school districts, universities, government 
entities, property management firms, utilities, energy service companies, and consultants. 

Helpful Lessons 

Lessons are available on the Abraxas Energy Consulting website at 
http://www.abraxasenergy.com/metrix-4-tutorials.php 

http://www.abraxasenergy.com/metrix-4-tutorials.php
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It is a good idea to go through these lessons if you have not used Metrix before as they will give 
you a good practical look at the software. 

Cost Savings vs. Cost Avoidance 

Did you know that it is possible for utility bills to increase and still be able to demonstrate energy 
savings? Similarly, a reduced utility bill, compared to last yearôs, is actually not the true measure 
of energy savings. If the weather was exactly the same during the two years being compared, 
then a comparison of utility bills might yield accurate ñsavings.ò More often than not, weather is 
not constant, facility operations change, equipment must be repaired, and blizzards or hurricanes 
cause shut downs. There is always a valid reason why corresponding months should have an 
adjusted expected usage for each year. The question then becomes, ñHow on earth can I 
calculate an expected building usage?ò Introducing the fundamental concepts of ñCost 
Avoidanceò and ñCost Savingsò. 

The problem is: we donôt have any physical instruments that can directly measure Energy or 
Dollars not spent. 

Example Scenario: Suppose a performance contractor installed an energy efficient HVAC retrofit 
in a customerôs store. More efficient means less energy and everyone is expecting to see energy 
costs go down. For June the customer might expect savings from Juneôs utility bill as shown in the 
Figures below: 
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Figure 1.1 Expected Pre and Post-Retrofit usage for HAVC retrofit example 

Now, letôs change the numbers a bit. What if, the customer saw this? 

 

June 2001 179,359 kWh

June 2002 152,455 kWh

Savings 26,904 kWh

June 2001 179,359 kWh

June 2002 197,295 kWh

Increase -17,936 kWh
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Figure 1.2 Pre and Post-Retrofit usage for HVAC retrofit example 

The customer is likely going to be looking for a very good explanation as to why bills were higher. 
Was the wrong equipment installed? Should the energy manager be fired? Energy efficient 
equipment canôt possibly make bills go up, right? Or, is there something else causing this?  

Perhaps, the temperatures in June 2002 were record setting highs, but the previous June had 
been subject to thunderstorms and more moderate temperatures. One would expect the air 
conditioning load to be much higher in the latter year. So, how could you ever measure savings 
from energy efficiency projects? Are all savings truly at the mercy of the weather? 

Of course not, all of the top performance contracting companies normalize their savings for 
weather to show savings and reduce risk. They use analysis tools such as Metrix, to remove 
weather from the savings equation so they can accurately quantify savings. 

The Cost Avoidance approach compares a ñBaselineò to the actual bills. The Baseline is a 
normalized value that represents the expected usage for a given set of conditions. That is: how 
much energy a building would have used, based on this yearôs conditions. Using your billing 
history, historical weather, and any other significant variables a user enters, Metrix will create a 
regression equation that relates then all together, thereby making it possible to predict an 
accurate expected usage. Users can adjust or ñtuneò the equation for the best possible fit to the 
data.  

Hot summer? It might be good to know how many kWh the previous air conditioner consumed per 
degree outdoor temp. Busy month? Letôs compare utilities to production volume. Crazy calendar? 
Occupancy might the key. 

The Cost Savings approach does not normalize for weather; there is only a head to head 
comparison of corresponding months between years. This leaves several questions unanswered. 
In the real world of energy analysis, this is completely inadequate. 
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Table 1.1 Cost Savings vs. Cost Avoidance 

Cost Savings = Last Yearôs Bill - This Yearsô Bill 

Cost Avoidance = 
Baseline (what your building 
would have used before the 
energy conservation measure) 

- This Yearôs Bill 

There are benefits to both approaches. The table below lists the benefits of both the Cost 
Avoidance and Cost Savings approaches.  

Table 1.2 Utility Bill Comparison vs. Utility Bill Analysis 

Cost Savings Cost Avoidance 

¶ Will not need to ñTuneò meters ¶ Will need to ñTuneò meters 

¶ Simpler method to use ¶ More complex method 

¶ Do not need to learn concepts behind or 
how to use: ñBaselineò, ñTargetò, 
ñModificationsò, ñMeasuresò, ñTuningò 

¶ Need to understand the concepts behind 
and how to use: ñBaselineò, ñTargetò, 
ñModificationsò, ñMeasuresò, ñTuningò 

¶ Requires less work ¶ Requires more work 

¶ Easy to explain to others ¶ Can be difficult to explain to others 

¶ Less accurate representation of savings 
from energy conservation projects 

¶ More accurate representation of savings 
from energy conservation projects 

¶ Can compare any year to any year 
¶ Can compare a Baseline, which is based 

upon one year of data, to current bills. 

¶ Can make Cost Savings reports, but NOT 
Cost Avoidance reports. 

¶ Can make both Cost Avoidance and Cost 
Savings reports. 

Established Metrix Features 

Ç Correction for weather data 

Metrix allows you to correct your utility bills for changes in weather. This allows you to 
make fair annual comparisons of utility bills. 

Ç Correction for User-Supplied Variables 

Metrix allows you to correct their utility bills for changes in user-supplied variables as well. 
This includes occupancy, school schedule, production, etc. 
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Ç Multivariable Regression 

Metrix allows users to correct their utility bills for not just one variable (i.e. weather), but 
allows you to make corrections for up to 5 variables. Some meters may supply energy for 
heating and cooling (that is 2 variables), and may vary based upon occupancy (a 3

rd
 

variable). 

Ç Variable Balance Point Degree Days 

Weather is imported (or entered) into Metrix as daily high and low temperatures. This 
allows Metrix to calculate degree days based upon different balance points rather than 
just 65 °F. Different buildings start heating and cooling at different balance points, and it is 
less accurate to assume all buildings start heating or cooling at 65 °F. 

Ç Tuning Statistics 

Metrix supplies R
2
 values and T-Statistics on the Tuning data form, and CVRMSE and 

Mean Bias Error values on the Tuning Report. These statistics can guide you towards 
performing reasonable regressions. 

Ç Bill Matching 

If you cannot tune your meter, Metrix allows you to instead compare usage from year to 
year without any correction for weather or user-supplied variables. 

Ç Meets IPMVP and FEMP Guidelines criteria for Option C Monitoring and Verification 

Metrix meets the International Performance Measurement and Verification Protocol and 
FEMP Guidelines criteria for Option C Monitoring and Verification. 

Ç Metrix has become the standard for Cost Avoidance for Energy Service Companies 

Metrix is routinely used by the largest Energy Service Companies to monitor their 
performance contracts. Metrix is used because it is an unbiased, industry-accepted, easy-
to-use method for determining and presenting cost avoidance. 

Ç Hands-on tuning screen 

The tuning screen keeps you from making poor correlations between independent 
variables and your utility bills. Since you are manually performing the regressions, you 
become aware of outliers, poor tunings, and can discover changes in utility usage during 
your Base Year. 

Ç Easy import of data 

You can easily import bill data, weather data, variable data, and other data into Metrix. 
Imported files are in comma separated variable (CSV) format, and are easily created in 
Excel. 

Ç Export of data 

You can easily export bill data, weather data, variable data, and other data out of Metrix 
into text files that you can open in Excel. 
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Ç Export of reports 

You can export Metrix reports into Excel, Word, html or other formats. 

Ç Baseline modifications 

When the building has substantial changes to its energy usage pattern (i.e. additional 
square feet, or additional equipment), you can easily add modifications to the Baseline 
scenario, which will result in a correct comparison of Baseline and Actual or SimActual 
data.  

Ç Target Scenarios 

You can easily set up Target scenarios, which you can compare to Baseline, Actual and 
SimActual scenarios. 

Ç Rate Modeling 

Metrix has a rate engine that can handle most utility rates. Whereas average costs can 
sometimes lead to erroneous results, the rate engine allows you to correctly apply costs 
to utility bills. 

Ç Average Costs or Rate Modeling 

Metrix allows you to use average costs or model your rates. You can choose either 
method. 

Ç Multiple Utility Rates 

Metrix allows you to assign different rates to different scenarios. This comes in handy 
when your meter was previously on one rate, and you moved it to another rate to save 
money. 

Moving From a Previous Version of Metrix 

NOTE: Before any install, make a complete back up copy of your work! This is just good practice 
for any software upgrade. 

NOTE: Metrix 3 projects saved in Metrix 4 are not backwards compatible. By all means, evaluate 
our software, but only open copies of your Metrix 3 projects when doing so.  

NOTE: All versions of Metrix 4 are compatible among other versions of Metrix 4, but must be 
saved as compatible version. Changes made to a project using the latest features may be lost 
during the save. Users sharing projects in collaborative efforts are strongly encouraged to use the 
same version of Metrix. 

Evaluators of the software should check over meter tunings to see if they have changed. If 
resetting meter tunings: 

Ç At the project level, under the project preferences tab, un-check ñGuarantee Zero Net 
Bias in Regressionò and ñMax Delta T Demand Tuningò  

Ç You may also encounter difficulties with bill-matching modifications. If so, you may have 
to delete and re-add the modifications. 
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Contact Info 

Mailing Address 
Abraxas Energy Consulting 
PO Box 230 
Santa Margarita, CA 93453 
 

NOTE: Abraxas Energy Consulting also has a network of international dealers. Please contact the 
Abraxas Energy Consulting Sales Department for information about contacting an authorized 
dealer in your area. 

Sales Department 

Ç Sales Phone: 805-547-2050 

Ç Sales Fax: 805-456-0180 

Ç sales@abraxasenergy.com 

Technical Support 

We are working hard to provide you with intuitive technical products. In addition, we try to provide 
superior online and print documentation to enable you to work independently in creating your 
Metrix projects. However, should you find yourself with a technical question that cannot be 
answered with provided tools, please contact our technical support department. All of our 
Technical Support Engineers are eager to answer your questions and help you create the best 
Metrix projects possible. 

Metrix Tutorials 

We highly recommend practicing the instruction you receive in this manual on the Metrix 4 
Tutorials. These tutorials are located online at http://www.abraxasenergy.com/metrix-4-
tutorials.php. There are eight lessons that cover most of the topics in this manual. This is a great 
tool to get some hands on Metrix training! 

FAQôs 

At our website, we have provided a list of FAQôs that covers most of the common issues 
encountered by users. Check out the FAQôs at the URL below: 

Ç Abraxas Energy Consulting Metrix FAQôs: http://www.abraxasenergy.com/faq.php  

Email Questions 

Ask questions and receive detailed answers from the Technical Support Department. Send 
emails to the address listed below. If you think the problem is associated with your project, send 
your Metrix project and we will look it over. 

http://www.abraxasenergy.com/metrix-4-tutorials.php
http://www.abraxasenergy.com/metrix-4-tutorials.php
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Ç Abraxas Energy Consulting Technical Support Email: helpdesk@abraxasenergy.com 

Fax 

Questions or comments can be faxed to Abraxas Energy Consulting. Just send to the fax number 
listed below. You will receive a reply by phone or email. 

Ç Abraxas Energy Consulting Technical Support Fax: 805-456-0180 

Telephone 

Abraxas Energy Consulting can be reached by phone between 8 AM and 5 PM, Pacific Time, 
Monday through Friday. 

Ç Abraxas Energy Consulting Technical Support Phone: 805-547-2050

mailto:helpdesk@abraxasenergy.com
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Chapter 2: General Project Layout 

The rest of this manual is a detailed, step-by-step guide to working with Metrix. It is organized as 
follows: 

Setting Up a New Project - Set up the Project layout by defining its Sites, Buildings, and Meters. 
Enter historic data, tune the meters, and establish performance targets. 

Tracking Utility Performance - Enter monthly data and track performance vs. expected savings. 
Modify the Project layout if necessary. 

NOTE: This manual does not cover making reports. For information on making reports, please 
see the Report Maker Manual. 

Should you like some hands on training, see the Metrix Tutorials section on page 9 of this 
manual. 

Overview 

A project is the equivalent of a ñWorkbookò in MS ExcelÈ, or a ñDocumentò in MS WordÈ. You 
can set up and maintain hundreds of projects if you want, but you will likely only have one or a 
few. A Project can consist of one building with one meter, or of dozens of buildings and meters.  

Below is an overview of what is involved in project set up. Each item listed below is treated in 
sections that follow. 

Once the Project has been laid out and historic information has been entered, you are ready to 
analyze its past utility performance patterns, and enter expected savings (if any) from your facility 
improvement measures, as follows:  

1. Tune the Baseline to establish typical past utility performance based on historic bills and 
variables.  

2. Enter performance measures that represent anticipated savings from facility 
improvements.  

3. Establish rate tariffs that determine how utility costs and savings are calculated. 

4. Check quality control to catch any potential errors.  

Note: Keep in mind that if you are not performing cost avoidance, and just want to compare year 
to year bills, then you can skip Tuning the Baseline and entering Performance Measures. You 
probably will skip Rates as well.  

After completing these steps to set up a historic model of the Project, it is a good idea to produce 
reports that summarize the Project so far. Details of report making can be found in the Report 
Maker Manual. Once you are satisfied with the Project set up, it is time to start tracking ongoing 
utility performance, as described in the section on Tracking Monthly Performance. This section 
also tells you how to modify the layout of the Project, if it changes during the tracking period.  
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Pre-Project Settings 

IMPORTANT: Currency, Metric/English Units, Tuning Preferences, File Locations, and User 
Information are important to set before any projects have been opened, Very common mistakes 
include:  

¶ Adding bill data in the wrong currency 

¶ Saving to the wrong location 

¶ Blank user info that causes collaboration errors across national borders and time zones 

Avoid costly mistakes and frustration by setting up your software before opening projects. Go to 
Tools > Options from the menu at the top of the Metrix screen. The following Options Dialog Box 
will appear as shown in Figure 2.1. 

 

Figure 2.1: User Options: General Field 

General Tab 

Units - If using Metric Units choose SI units. North American users can choose IP for 
English Units. 

Currency - Selecting Default Currency will adjust all costs to this currency regardless of 
what currency bills are entered in.  
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Example 1: a US utility bill of $100 would be viewed by a user in China as $680 Yuan (1 
dollar = 6.8 Yuan approx.) Equal value bill amounts mean less confusion for users.  

Example 2: if the user in China adds bills to the US project, then they would add a Yuan 
value because they are viewing Yuan. If they are holding bill data for the US customer in 
dollars, then it may be better to open the project in dollars, view dollars, add dollars, and 
then be able to send the project back to the US without errors. 

NOTE: if your Metrix settings are different than those of a project you want to open, you 
will automatically be prompted by the window shown below in Figure 2.2 

 

 Figure 2.2 Currency Conversion Window 

Quality Control - QC Check on Startup can make a quality control check standard when 
you open any project. Quality Control is an extremely helpful tool. All tech support queries 
will start here and a vast majority are resolved by addressing the errors found by Quality 
Control. Users are highly encouraged to leave this box checked. 

View ï This box allows the user to set view defaults to suit preference. 

Expanding Project Tree - when open will fully expand all project elements when a project 
is first opened. Typically not a good idea for projects with more than 25 meters; it results 
in too many scroll screens. 

Show Tuning Marks - for Meters deals with the red or green checkmarks that will appear 
next to a meter that is tuned. Green meaning tuned, red for un-tuned. Users who are not 
planning on tuning meters at all are very rare; it is recommended to leave this box 
checked. 

Default Meter Page - selects the tab in the right pane that will be viewed first when 
selecting an item in the project tree. 

Show Item Numbers - will assign a number before the name of any project element. 
Example : Site 5 ñCenter Buildingò. 
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Save Projects As Metrix 4.4- will save all projects as Metrix 4.4 compatible. The new 
Metrix 4.5 features such as Monthly Minimum costs are not available in a project saved 
as 4.4 compatible. For projects created in Metrix 4.4, this box will be checked by default. 
New projects will have this option un-checked. 

Tuning Preferences Tab 

The Tuning Preferences Tab allows users to adjust how auto tuning finds the ñoptimalò regression 
equation. The default values are recommended unless the user has good reason to change the 
preferences. 

 

Figure 2.3 Tuning Preferences Tab of Metrix Settings 

Equation Formula ï When you select auto tune, Metrix will tune many different ways. The 
tuning which results in the largest score for the equation formula is used. The equation 
formula can be adjusted to the users liking by adjusting the statistical indicators within the 
formula, the values they are compared to and the multipliers. 

Multipliers will weigh the statistical indicators within the equation formula to your 
preferences. If you think having a low mean bias is twice as important as all of the other 
statistical indicators, you should put C = 3. If you do not want a statistical indicator in the 
equation, simply uncheck the box to the left of it. 

File Locations Tab 

Carefully select the default locations where you would like to save your projects to prevent losing 
your work.  

Templates are sample project files. There are several pre-loaded into the Metrix software 
in the Resources folder. You may wish to create some templates of your own for 
particular jobs, customers, fuel types, etc. 
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Report Maker tells Metrix where to find the Report Maker Program so it may be started 
through Metrix. It does not tell Report Maker where to save reports; this is done through 
the Report Maker Settings. 

Metrix Data address allows the user to set the default location for where to save projects 
created in Metrix. This will also be applied to data which is exported from projects. NOTE: 
there is an important sample project named GULFMED.PJY in the default folder, data. It 
is highly recommended that users save a copy of this project as a reference or learning 
tool.  

User Information Tab 

Contact Information as including general global location can save much time and frustration in the 
future should your projects ever be involved in a collaborative effort over vast distances. Even for 
the sake of technical support, leaving contact info will be of great benefit. It only needs to be done 
once. Metrix will prompt any other user when opening a project with this information if it detects a 
change in time zone, nationality, currency, or unit system. This helps to prevent improper project 
modifications. 

 

Figure 2.4 User Information Tab in Metrix Settings 

Building a Project Tree Structure 

If you create a new Project from scratch, Metrix provides a ñshellò Project as your starting point, 
which is called New_Proj. This contains one each of the required Items for a Project: one Site, 
one Area, one Meter, and so on, as shown in Figure 2.5. You may modify these Items and add 
new ones as needed to set up your actual Project. 

From the File menu, choose New Project. This creates a new ñshellò Project. 

From the File menu, choose Save.  

Enter a new file name such as MYSCHOOL without any extension. Metrix automatically adds .pjy 
to indicate that it is a Project file. 
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Figure 2.5: A New Project Created from Scratch 

If the Project is not yet expanded, you can expand the Project Item, and any other item in the Tree 
Structure, by clicking on the plus symbol ( ). The Project contains one or more Sites; each Site 
contains one or more Areas; each Area contains one or more Meters; and each Meter could 
contain one or more Sub-meters. You may add as many of each Item in a Project as necessary. 
Each time you add a new Item, fill in the Data Form associated with it.  

In any location within the Tree Structure, you may make additions by right-clicking on the Parent 
Item above which you want the new Item to appear. Then, from the drop-down menu, click ñNewò, 
and then select the Item you want to add. Please view Figures 2.6 and 2.7 for more detail.  

A Projectôs layout is the organization of its Sites, Areas, Meters, and Sub-meters, which are 
defined as follows: 

Site - the geographic location for one or more facilities. A Project may have just one site 
(a hospital for example), or it may have multiple sites (for example, a school district might 
choose one site per school). All areas attached to a site share the same weather data.  

You may add as many Areas in a Site as needed but remember: Sites contain weather, 
Areas do not. If your Areas require different weather stations, you might want to make 
them Sites instead.  

Area - the portion of a site that has its own meters. Often, an area is a building, but it may be 
part of a building (such as one wing or floor), or it may be a different type of facility (such as 
an outdoor swimming pool). If the meters measures utility use for the whole building, the area 
should represent the whole building; but if the building is divided into sections with different 
meters, each could be a separate area. 

If you are planning on adding your own Variables to your Project, then be advised that 
Variables are attached to Areas. For example, if you have a factory that produces Bolts and 
Widgets, you might want to add the Bolts Produced Variable to the Bolt Assembly Line Area, 
and the Widgets Variable to the Widget Assembly Line Area. 

Meterðthe device which measures utility use and possibly demand. You should have historic 
and current utility bills for each meter you wish to track (electricity, natural gas, water, solid 
waste, etc.). Adding data to meters will be discussed in later sections. 
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Sub-meterða meter which is attached to a meter (for example, it is ñdownstreamò from a 
meter). It is usually used to subtract utility use from its parent meter. For example, if the 
customer adds a new piece of process equipment in year three of a performance contract, 
and you are sub-metering its energy usage, you can use a Sub-meter Item to subtract that 
use from the parent meter. 

Be aware, Sub-meters in Metrix are not like sub-meters in real life. Also you cannot make 
reports at the Sub-meter level in Metrix. Suppose you have a couple of main meters in your 
facility and a collection of sub-meters. In this case, you might want to represent this 
configuration in Metrix by listing the real-life sub-meters as Meters in Metrix, and ignoring the 
main meters. There are many different ways to do this, without double counting usage at the 
Project level. The main reason for using a sub-meter is to remove recently added new usage 
(building additions) from your savings equation. 

A Project must have at least one Site, Area, and Meter. Sub-meters are optional, and rarely used. 
The simplest Project is a single building with a single meter, which would consist of just one Site, 
one Area, and one Meter Item. 

As a general rule, you can make reports at the Project, Site, Area and Meter level. When laying 
out your project, keep this in mind.  

See Chapter 4 for examples of different Project layouts, including complex configurations 

Adding Project Items 

Before adding an Item, use the Tree Structure to find the desired location and select the Parent 
Item above which you want to attach the additional Item.  

For example, in the Tree Structure, the Area Item is attached to a Parent Site Item, as shown in 
Figure 2.6. Thus, to add a new Area Item, you must first click the Parent Site Item that you want to 
attach the Area to.  

 

Figure 2.6: Tree Structure 

From the Edit menu, choose New, or right-click on the Site Item and choose New. A drop-down 
list displays the types of Items you may add in this location as shown in Figure 2.7. Choose to add 
a new Area. 
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Figure 2.7 Right Click Options to add new project items 

Metrix names the new Item with its Item type, which may be followed by a number and a set of 
empty quotation marks. To give it an actual name, click once on the Item to display its Data Form 
(on the right) and fill in the Name field.  

Deleting Project Items 

1. Click the Item you want to delete. 

2. From the Edit menu, choose Delete, or press Delete on your keyboard. (You can also try 
right-clicking on the Item, and selecting Delete from the menu that appears.) 

3. The Delete Block dialog box appears, as shown in Figure 2.8. 

4. Click Yes to delete the Item.  

Figure 2.8: The Delete Block dialog box 

Using Elements from Existing Projects 

If you start from an existing Project, you can transform it into a new Project quickly by opening the 
existing Project and saving it to a different name. This may be the best approach when you are 
creating a new Project that is similar to an existing Project. 

From the File menu, choose Open. The File Open dialog box appears, as shown in Figure 2.9.  
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Figure 2.9: Opening a File 

Select and open the old Project you would like to use as the basis of the new Project. A Security 
Check message may appear, noting who last modified the existing Project. 

From the File menu, choose Save As and save the Project under a new name.  

Using the Pre-made Project Elements 

Metrix has common projects elements such as rates, meters, etc. pre-made for users to 
copy/paste into their projects. 

Go to: hard drive > program files > Metrix 4 folder > Resource Folder. 

The .TPY files are template files. NOTE: use copies of these to avoid ruining the templates. 
These files are typically very similar to Gulf Med, but they have a project element within them. 

Navigating Large Projects  

Projects may contain hundreds of meters. For these instances navigating through the project tree 
is made simpler by sorting project elements by parent or by type. The option to change from the 
standard tree structure to the sorting option is found just above the left hand pane. (Shown below 
in Figure 2.10) If you do not see these bubble options directly above the project tree, go to the 
View > Show List View to make it appear. 

 

Figure 2.10: View Options 

Items can be sorted by Meter, Area, or Site. Figure 2.11 below shows a meter level view sorted by 
parent. Notice in that the Tree Diagram has been replaced with a listing. Click on each of the drop 
down menus to see what options are available.  
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Figure 2.11: List Style View allows users to sort project items 

Project Data Panes 

Project Information Tab 

Typically the project information tab only needs to be set during initial project build up. (Users can 
also refer to Metrix Lessons for more information) 

 

Figure 2.12: Project Information Tab 

Name, Description, ID ï descriptive information concerning the scope of the project. The 
ID field is optional. 

Country ï it is highly recommended this field not be left blank. Metrix checks this against 
the user settings on the computer it is being opened on to adjust for currency. 

Reference Year ï allows users to set what month will be at the end of a 12 month year 
when reporting. For example: if your fiscal year ends September, select that month from 
the drop down menu. 
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Current and Entry Close Dates: 

¶ Current Date, Use System Date ï Metrix is asking the user what day today is. By 
checking the Use System Date box, the program will sync with the date on your 
computer. It is recommended to leave this box checked. 

¶ Entry Close ï Only if a project has been protected with a ñRead Onlyò Password 
will this setting take effect. Allows users to lock out data from being adjusted 
beyond a certain date. Password settings are found under the File > Set 
Password. 

Milestone Dates - serves as helpful reference information to users. Most commonly 
associated with performance contracting. This information is optional.  

Contact Information Tab 

All of these fields are self explanatory. Fill in company information and any contacts as desired.  
(This information is also used by the Metrix Report Maker when using the ñEmail Reportò feature.) 

Note: these fields are applied to the project file, not to your installation of Metrix. The contact 
information that can be entered in the Pre-Project Settings under Tools > Options is assigned to 
your installation of Metrix. 
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Project Preferences Tab 

 

Name ï sets the name of the project. 

Project Preferences: 

¶ Tune Only Sum TOU Periods ï Only for use when there are multiple Time Of Use 
Periods. Metrix will sum all these periods and tunes to that value. If unchecked 
users will need to tune each TOU period individually; that can be difficult. 

¶ Override User Bill Selection / De-Selection ï if Metrix is unable to tune the data 
with the userôs selected bills, it will select or de-select any that would result in a 
better set of statistical indicators (with a maximum number of bills selected). Only 
bills within the total span chosen for the base year are considered for 
selection/de-selection. 
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¶ Override User Tuning Variable Selection ï if Metrix is unable to tune to all or 
some of the users tuning variables, it will select or de-select any that would result 
in a better set of statistical indicators. 

¶ Max Delta T Demand Tuning ï Metrix will only consider the day with the maximum 
number of Degree Days for a given bill. This only applies to demand metering 
where the demand is billed for the highest value in a given period, but is not a 
requirement for all demand situations. 

¶ Guarantee Zero Net Bias in Regression ï Sets the net zero bias to zero. Note: 
may cause meter tunings to change. Tunes the regression equation so that the 
Baseline values are within .005% of Actual values in the Base Year. It is highly 
recommended this remain checked. 

¶ Use Zero Default Degree Day Threshold ï if unchecked the default degree day 
threshold is 2 degree days. Any bill period containing less than 2 degree-days will 
be automatically de-selected. Example: a gas meter would have no HDD in 
summer, so those months would be de-selected. Checking this box is optional 
but recommended. The reason is that bills with few degree days will tend to have 
a zero for the weather related term in the Baseline Equation anyway so they can 
be left as selected. 

¶ Set All Bill Cutoff Dates to ï Metrix will set all bill cut-off dates to match the 
options that are selected 

¶ Set All Tuning Periods to ï Metrix will set all tuning periods to match the setting 
selected i.e. number of bills and starting bills 

¶ Automatic Bill Cutoff Dates ï by pressing this button all bill cut-off dates will be 
applied following the follow rules 

o If the bills are not near the 15
th
 of the month, Starting on 15 will be used 

o If the bills are near the 15
th
 of the month, but mostly higher, Starting on 

25 will be used 

o If the bills are near the 15
th
 of the month, but mostly lower, Starting on the 

5
th
 will be used. 

Tuning Requirements Tab 

These are numbered as they appear in the Metrix screen Note: the default settings are highly 
recommended.  

1. R
2 
(Quality of fit): 0.75 or higher, with 1.00 as perfect fit. 

2. CVRMSE Eng (Coefficient of Variation Root Mean Squared Error): 25 or lower for 
consumption meters. 

3. CVRMSE Dmd (Coefficient of Variation Root Mean Squared Error): 35 or lower for 
consumption meters. 

4. Abs (Mean bias) - Must be equal to or less than 0.005. 



Metrix 4 Userõs Guide  Chapter 2: General Project Layout  

  26

 

5. Abs (T-Stats) - Positive 2.0 or higher for CDD and HDD, and greater than 2.0 or less than 
-2.0 for any user variable. 

6. HDD and CDD T-Stat > 0. This box must be checked to be ASHRAE and IPMVP 
compliant. The reasoning behind this is that an increase in HDD or CDD should correlate 
with an increased amount of energy use. 

7. Tuning Constant >= 0. This box must be checked to be ASHRAE and IPMVP compliant. 
A negative tuning constant implies that when all variables tuned to are zero, there is 
negative energy usage. 

Report Groups Tab 

(See section ñHow to Use Grouping in Metrixò) 

Notes Tab 

Click the Add Note Button and enter the Date, User, or Note as you wish. Any portion of this 
information may be left blank if desired. Any information entered into these fields many be 
changed at any time. Note: be sure to click Save Notes. The asterisk indicates new changes have 
not yet been saved. 

User Data Pane 

The operatorôs name, contact email, address, and phone numbers will appear in the reports.  

In the tree diagram, click the User Item to display the User Information data form, shown below. 

 

Figure 2.13: Project Information Tab 

Since all of these fields have been entered in the user form in the Pre-Project settings, this form 
can be auto-populated by clicking on the button that says Copy from Options | User Info. 
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Site Data Panes 

As a reminder, sites are typically designated by their street address. Sites have their own 
weather. Many sites can all be in the same city (and thus would have the same weather added at 
each site) but that is not the same as making each building at the same address its own site. For 
an address with many buildings, each building would be better designated as its own area within 
the same site.  

Site Information Tab 

Name, Description, Country ï these are self explanatory. Tip: keep in mind that large 
projects can be sorted by description as well. 

Current Floor Area - Metrix automatically sums the Current Floor Area field from all 
building areas that are part of this Site.  

Groups ï (see section How to Use Grouping in Metrix on page 92) 

Contact Information Tab 

These are self explanatory. Enter contact info pertaining to that particular site where applicable. 
(This information is also used by the Metrix Report Maker when using the ñEmail Reportò feature.) 

Area Data Panes 

As a reminder, all areas at a site will have the same weather of that site. Typically, they also have 
the same address but are unique in construction to warrant splitting the utility tracking. An 
example: east and west wings of a single campus where usage is not similar. 

Area Information Tab 

Name, Description, Country, State ï are all self explanatory. Tip: keep in mind that large 
projects can be sorted by description as well.  

 Type of Area ï select from the drop down menu 

Groups ï (see section How to Use Grouping in Metrix on page 92) 

Current Floor Area ï this is editable only from the fields below with the column headers: 
Date, Total Area sqft, Percent Condition, Comments. If a user is interested in 
benchmarking their facility, this information is required. 

Contact Information Tab 

These are self explanatory. Enter contact info pertaining to that particular site where applicable. 
(This information is also used by the Metrix Report Maker when using the ñEmail Reportò feature.) 
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Meter Data Panes 

Meter Setup Tab 

Name, Account, Description ï Relatively self explanatory, these determine the name for the 
selected meter, assign an account # to it, and allow the user to enter a description. Note: the 
account you enter must exactly match the account # on the Import Tab as well. Metrix will 
automatically prompt users when a change occurs in the account # in either tab and offer to 
synchronize them for you. 

Utility ï Select the utility type from the drop down menu. Notice the units associated with the meter 
type will also change accordingly. 

Degree Day Calculation Method: 

¶ Daily Degree Days - are the difference between the average temperature for a day and 
the selected balance point. 

¶ Degree-Hours/24 ï when checked, assumes a standard hourly temperature profile for a 
day when hi/low weather is available. Averages HDD and CDD separately based on this 
profile. Can provide CDD and HDD for a given day. Note: not recommend for most 
projects. 

¶ Max Delta T Demand Tuning ï Metrix will tune the meter according to the highest degree 
day recorded for a billing period. Note: this can be, but not always be, a more accurate 
way of correlating demand data to weather. It is based on the idea that the highest 
demand will occur on the day of the highest weather differential. While that is the case for 
many buildings, it is not always perfectly reflected how the building is metered. 

Utility Pricing 

¶ Single Utility Rate Schedule ï Applies the rate and charges to the meter; most common 
user setting when rate tariffs are available. 

¶ Multiple Utility Rate Schedule ï this allows users to set up to 3 different rates and charges 
for the same meter data and assign them separately to the Baseline, Target, and 
SimActual. 

¶ Avg. Cost/Consumption & Cost/Demand ï if a rate has not been entered for this meter, 
Metrix will calculate an average cost/consumption unit or cost/demand unit. Where the 
cost has been entered in the On Peak Cost Column in the Bill Register. (Not to be 
confused with the Total Cost Column in the Bill Register.) This column is only available 
when the Detailed Cost Box is checked next the # of TOU Periods box. If the ñDo not 
prorate Misc Costs when calculating Ave Cost/Energy and Ave Cost/Demandò box is 
checked, the Misc $ amount will be identical in the Simactual and Baseline. Otherwise, 
the Misc charges are prorated based on whether the energy consumption and demand 
costs increase or decrease. 

¶ Avg. Total Cost per Consumption ï if a rate has not been entered for this meter, and the 
only cost available is the Total $ column, Metrix will use the total cost/consumption or 
cost/demand. Taxes, Credits, and Miscellaneous Costs are all included in this calculation 
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method making it less precise. It is helpful as an estimate tool or when rate tariffs are not 
available. 

¶ Min/Unit ï over-rides the any unit pricing below the set limit. If the Monthly Minimum radio 
button is selected, users may enter a monthly minimum cost.  

¶ Min/ - over-rides any bill lower than the set limit 

Notes ï Allows users to record or communicate information of their choosing. 

Register Tab 

This contains the Actual Utility Bill Data for the meter. 

(See section: Entering Historical Data for more information concerning Data Entry and Feature 
Available to all Data Registers) 

# TOU Periods ï Time Of Use Periods. Adds columns to the Bill Register when more than one 
consumption quantity is available. 

Detailed Cost ï Adds a cost column next the consumption column in the Bill Register when utility 
bill data is available with the unit cost broken out from the total cost. (that is, with no tax, or 
service charges) 

1
st
 Day of First Bill ï All of the bills in the register (except the first) contain only one date, the end 

date. Implicitly, the start of each bill is the end of the previous. A common question is how to 
ungray the 1

st
 day of bill box. When the bill register is not all the way at the top, the 1

st
 day of bill 

will be locked. To unlock, simply scroll to the top of the bill register. Note: Another common error 
is to leave this field unadjusted, resulting in an improper baseline for the first month. 

Total $ 

¶ Automatically Calculated will over-ride any pre-existing costs in the Total Cost Column by 
summing any Detailed Costs, Tax, Credits, or Misc. Costs. You must have at least one 
Detailed Cost column turned on in order to select this feature. 

¶ Manually Entered ï Allows users to enter any amount into the Total Cost Column. 

Bill Cut-offs ï  A bill cut-off date is used in Report Maker to assign the bills to a month based on 
the day the bill ends. This feature is necessary since bills do not always start on the first day of 
the month and end of the last. If a bill ends on May 31

st
, it is a May bill, if it ends on June 1

st
, it is 

also a May bill. However, when a bill ends on June 15
th

 it becomes more difficult.  

Metrix will determine how to assign these bills based on the options the user selects.  

For example, if the user has the options ñStartingò and ñ15ò, this means that if you look at a bill 
end day, the bill will be considered the month that the bill ends in if the bill end day is between the 
15

th
 of the month the bill ends in and the 14

th
 of the next month.  

Specifically, if the bill end on 6/22 and the options ñStartingò and ñ15ò are selected, the rule is: 
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All bills that end between June 15
th
 and July 14

th
 will be considered a June bill. Since the bill ends 

on June 22
nd

 it is between the period and the bill will be assigned to the month of June for 
reporting purposes. 

In the Project Preferences tab, there is an option to set all bill cut-off dates for all meters manually 
or automatically.  

Tuning Tab 

(Also: see Complete Meter Tuning for information concerning interpreting the data displayed in 
this data pane) 

Tuning Period - this is set by the # of Bills and Start at #. Check the ñstarting onò and 
ñending onò dates to verify settings are correct. 

¶ # of Bills ï this is the # of sequential bills that a user would like to use as the basis for 
the Baseline Equation. (not necessarily the total number of bills) 

¶ Start at # - sets the first bill of the # of sequential bills based on the bill register. (i.e. if 
there are 13 bills, and you tune for 12 months, setting this to 1 excludes the last 
month) 

TOU Period ï Only if ñSum TOU periodsò has not been checked. Choose the desired 
consumption data to tune for. 

Show Eng/Day ï displays the ratio of utility unit per day for each bill in the mini-register. 

Show Degr Days ï displays the number of Degree Days for each bill in the mini-register. 

Tuning: Closed Check Box ï checking the box for closed will lock the current tune of the 
meter in whatever state it is in.  

Tuning: Manual Check Box - checking the box for manual allows users to directly enter 
Baseline Equation Regression Coefficients. 

Auto Tune - (see section on Complete Meter Tuning for details) 

Bill Match ï (see section on Bill Matching in Complete Meter Tuning for details) 

Set Fit to Zero ï clears the Baseline Equation Coefficients. Note: all meter tuning will be 
lost.  

ñTune Withò: Check boxes ï selecting these tells Metrix what variables to tune with. The 
default boxes are HDD and CDD for heating and cooling degree days. Additional boxes 
will appear for user defined variables when they are added. 

Bal Point ï (see section on Complete Meter Tuning for details) 

Thresh ï (Threshold) the lowest number of HDD and CDD of the bills selected in the 
tuning period. 
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RegrCoeffic: (Regression Coefficient) Matches the tuning variable coefficient in the 
Baseline Equation. Tip: compare to the numbers in the Baseline Equation displayed in 
blue. 

T-Stats ï (see section Statistical Indicators in Complete Meter Tuning) 

Baseload: (Regression Coefficient) Matches the # Days coefficient in the Baseline 
Equation. Tip: compare to the days coefficient in the Baseline Equation displayed in blue. 

Graph X-Axis ï select from the drop down menu the desired units for the graph. (see 
Complete Meter Tuning for details) 

Moving S/A ï (Moving Smoothed Average) helps to show general trends, but should not 
be used while tuning. 

Scenario Inspection 

Many of the controls displayed on this tab have very similar counterparts in the tuning tab. 
However the main purpose for the scenario inspection tab is for users to be able to see a visual 
comparison of their Baseline, Actual, SimActual, and Targets and values for each individual 
scenario 

Use the check boxes to add or remove any of these 4 scenarios to you graph. Be sure to select 
the different x-axis available as well. 

Baseline Scenario - utility usage for the meter is calculated by Metrix based on the 
meterôs past typical performance. The Baseline is usually compared with the Actual 
Scenario to see if any savings are being achieved, or to see if utility usage is changing 
over time, after correcting for weather and other variables. The Baseline usage is 
calculated by Metrix with coefficients you derive from tuning the meter. Costs for the 
Baseline Scenario are calculated by Metrix based on the Cost Calculation Method 
selected in the Meter Setup Data Form. 

Target Scenario - reflects the goal or budget you establish for utility usage and costs. For 
example, if you were implementing an energy management program which you expect to 
reduce your utility costs by 30%, you would set up the Target Scenario to be 30% below 
the Baseline. Then, you can compare the Actual utility costs to the Target, and determine 
if you are achieving your goals. The Target usage is calculated by Metrix by applying 
Measures to the Baseline usage. Costs are calculated by Metrix based on the Cost 
Calculation Method selected in the Meter Setup Data Form. 

Actual Scenario - reported usage and cost are taken directly from the utility bills for the 
meter. These are entered by the user or automatically imported into Metrix if the bills are 
available in electronic format. 

SimActual Scenario - utility usage is taken directly from the utility bills, as it is in the 
Actual Scenario. But costs are calculated by Metrix based on the Cost Calculation 
Method selected in the Meter Setup Data Form. You can use the SimActual Scenario to 
validate the utility billing, or to compare the impact of alternative rate tariffs on utility bills. 

SimActual Tab 

The cost values in this register are calculated using the Actual Consumption or Demand 
according the rate for that meter. This is also subject to the cost calculation method selected. (see 
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Meter Setup Tab) If no rate has been entered, it will be a duplicate of the Actual Bill Register. It 
will always display grey-ed out data, and users cannot directly edit the fields in the register.  

This information is useful when comparing billed costs to published rate tariffs; especially when 
there is a billing discrepancy. Sometimes alternate rates are available for a given building; by 
modeling both rates, users can compare if to see if the alternate is more beneficial. 

Import Tab 

Name, Utility, Account ï Metrix uses these fields when importing or exporting meter data. Note: It 
is critical that these fields match their counterparts of the same name in the Meter Setup Tab. 
Metrix offers the user to automatically synchronize these fields by prompting the user anytime 
there is a change made. 
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Chapter 3: Populating the Databases 

Manual Entry vs. Import Files 

When the term ñManual Entryò is used, data is being added directly where it is viewed in the 
register where it is stored. Pro: simple, intuitive. Cons: too slow for large projects.  

Import Files allow users to add, modify, or transfer large amounts of data in one swift move. 
Example: an initial project build involving 10 years of billing history should not be entered one bit 
at a time. 

All data registers can be modified manually or with an import file 

Types of Data Registers 

ñRegistersò are the row/column spreadsheets of Metrix data. There are different kinds, designed 
for each type of data they are meant to contain. Users can inspect or modify the data through the 
registers, although there are other methods as well. The types of registers are: 

¶ Utility Bill Register 

¶ Weather History 

¶ Modification History 

¶ Measure History 

¶ Fuel Adjustment  

¶ Variable Information Register 

¶ Sub-Meter Register 

Each of these is discussed fully in their own respective sections; the intent of this section is to 
introduce the commonalities among them. 

Functions Available for All Data Registers 

Most common is the manual form of data entry directly into the cell where it is viewed. A single left 
click on the desired cell is sufficient to begin editing. For correcting typos small amounts of data 
this is fine. Note: Data entry or editing for medium to large projects should involve copy/paste 
functions from Excel or creating import files. 

Manual Entry 

A single left click on any cell of a data register opens it for editing. This is very straight forward. 
Good for small adjustments, but definitely not the preferred method for project level data entry. 
Continue reading for more powerful data entry tools like copy/paste and import files. 
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Figure 3.1 Editing the Bill Register 

Right Click Options 

A standard palate of 5 options is available by right clicking anywhere in register window pane. 
They are: 

¶ Add Row (New) - Creates a new blank row beneath the last data entry 

¶ Add Row (Copy) ï Copies any highlighted row and pastes it beneath the last entry. The 
dates will need to be changed to avoid having a duplicate bill. 

¶ Delete Row ï deletes the highlighted row. 

¶ Select All Rows ï highlights all the rows in the data register so they may be copied without 
the column header; useful for pasting to a larger list in Excel. 

¶ Copy All Rows ï copies the entire data register including the column headers; useful for 
pasting into Excel. 
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Figure 3.2 Data Register options for blank space right click 

Copy / Paste For Any Data Register 

Select the desired Metrix data to copy with a right click anywhere in the data register. You can 
choose Copy All Data, OR choose Select All Data then Ctrl+C. The entire data register can now 
be pasted into Excel by right clicking the cell where you want the top right column/row cell to be 
and choose paste. Individual rows may not be selected for a partial copy of data register, but a 
single cell can. 

Sample Copy / Paste from Excel from Metrix: 
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Figure 3.3 Copy from Data Register to Excel 

The paste function can be used very similar to how one would expect to use it in Excel, but with a 
couple of important differences. Notice both what it can and cannot be used for. 

Users may paste into a data register in the following ways: 

¶ Value of a single cell 

¶ Replace entire rows 

¶ Replace partial rows 

¶ Replace the entire register 

¶ Add any number of rows 

While very close to a typical paste function, it is not completely identical. For example: 

¶ May not add columns, column # and type must match before the paste operation. 

¶ May not paste in between rows 

¶ May not subtract rows; they must be manually deleted 

Sample Copy / Paste into Metrix from Excel: 




























































































































































